BR - OINI Project Creation

Domain: Country Accounting Responsibility area: N/A
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1. Objective and Scope

1.1. Objective of this Operation

This procedure explains how to create OINI projects (R&D WBS) in SAP for Brazilian companies.

1.2. Scope

This procedure applies to Brazilian companies in WP1.

Scope

?  Unknown Attachrment

ERP
wP1
Frequency

?  Unknown Attachment

References

CN43N, CJ01,; CJ02

Forms

Person Responsible and Positions

Attachments

Previous OP << BR - OINI Project
Creation >> Next OP


https://aodocs.altirnao.com/documentViewer.html?locale=en_US&aodocs-domain=solvay.com#Menu_viewDoc/LibraryId_Qgsyslj0VyghPWD939/DocumentId_RUWdd43xJwGOVY37ab

2. Definitions

See Finance Glossary:

* |[ECRA
* WBS
* WP1

3. Tasks description

There are 3 types of creation request:
® 1stlevel - Beginning - OINI heading
® 2nd level - Project

® 3rd - Subproject

The difference is in the field "level" that must be filled accordingly.

Display Project: WBS Element Overview
B9l ®

Proj. def.  |BR.GPLXEC Ic3 [HPc_MCs KEY_LA |

Basic data | Dates . Assgnments - Responsbilties | Control . Total |

S Lev |WBS element Description

‘ BR.GPLXPC HPC_MCS KEY_LA
BR.GPLXPC.124 HPC SCOUTING WORK - BRAZIL
BR.GPLXPC.124-01-1 HPC SCOUTING WORK - BRAZIL

The requests can have 2 formats: For the 1st creation, it is sent only a template with some information in square format.

® 1st format: request with the information in square format.

Solicitagdo de Cadastro de Ol ¢ QINI

Nome OIMI - PROJETO PARIS
Descrigdo OIMI - PROJETO PARIS
Centro de Custo 7515-5001

Centro de Custo Liberador T515-5001

Centro de Lucro T523-10571

Categoria 30

GiEnaEro iC

KRS Wao estimado
Empresa RHPA

Divisdo 7523

Local ACTW

Data Solicitada 1040372017
Solicitante helizsa Menezes



https://wiki.solvay.com/x/9gCqCQ
https://wiki.solvay.com/x/2ANNCQ
https://wiki.solvay.com/x/2ANNCQ

In this type of request, the name of the heading is not informed, we need to search it in CN43N.

Fill in the Variant 7523_OINI

Project Info System: WBS Elements Initial Screen

(& W E2atve =J A DBprofie mgDBprofie J» Status
Project Management Selections (DB profile: 000000000001)
Projekt [] | BROO* to o
WES element to C
Additional WEBS element criteria
Level 1 to 8%
Layout /R&I_PROJ-ST

Select the column "Project definition", sort by descending order and see which is the last project created.

S|S0 1| T @ 4B 4| L [[]]|88 (B 4P faa4
Project Definitions
B Proj. def. * WBS element Name Level Acct
BR.001230 BR.0O01230 OINI - WILLISA ER 2019 1
BR.001230.01 OINI - WILLISA ER 2019 2(X
BR.001231 BR.001231 OINI_SPARTA (GEC-LA 082/18) 1
BR.001231.3 OINI_SPARTA - Estudo Basico 2 (X
BR.001232 BR.001232 OINI_CRETA (GEC-LA 081/18) 1
BR.001232.3 OINI_CRETA - Estudo Basico 2 X
BR.0D1233 BR.001233 OINI-ESTUDO CLIMATIZACAO TEXTURACAO 1
BR.001233.01 OINI-ESTUDO EL]]’*'IP;TIZACEG TEXT BARMAG 2X
BR.0O01234 BR.0OD1234 OINI-Consulting Ceclofen 1
BR.001234.1 OINI-Ceclofen Analysis R&I 21X
BR.0O01235 BR.0OD1235 OINI_BOPE (GEC-LA 0003/19) 1
BR.001235.3 OINI_BOPE - Estudo Basico 2 X
BR.001236 BR.001236 OINI_MECAN (GEC-LA 007/19) 1
BR.001236.1 OINI_MECAN - Ordem de Grandeza 2 X
BR.001237 BR.001237 OINI_MOVE K2412 (GEC-LA 006/19) 1
BR.001237.1 OINI_MOVE K2412 - Ordem de Grandeza 2 (X
= BR.001238 BR.001238 Despesas Logisticas Resales CLA 1
BR.001238.1 Despesas Logisticas Resales CLA 2 X

® 2nd Format: from the 2nd level onward, the requester sends an excel file and a Google Drive link.
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® PROL-POSTL PROLPRCTR PROJVEUK PROJ-WER| PROJPLEAZ PRPS-ZZ_POSI PROJ-VERNR | PRES-PRART.

YERIGDO -LOTE Tipo o projes = 10cal T GaertadaGBU T

= NOWE_EWPRESE T NOME_ARES - HOME_cBU ® T MEDIS = 2 SOCIET lads amie =

L1 |NovaoN
oe1 nowON

DanislaManiqus  [50004630 7525178 7D

POUAMDA
o DanislzManigus  [50004650 7528178 "D

Recaptr NP
oA eoaplr G

® Both formats must have the following information:
© Company

Period

Project type

Level

Project name

Area or CGU (in order to search the profit center)

Cost center

Division

Profit center

Entry date (in case of a new project)

Manager / requester

Responsible

Type (if it is Ol or RD - for OINI is RD)

O O 0O O O O O 0O O 0 0 O

3.1. | create the heading of the WBS Expense

CJo1

® [Insert the number of the new project in the field Project Def.
® Select option Z025 - Overhead Costs.

Create Project: Initial Screen
= (i open number

Project Def. BR.001175

Project Profile 2025 - Overhead Costs -
Template
Project def,

Std proj. def.
With WBS Documents
Templte Profie Data

ENTER

In this step, we have the following information:

Project name
Person responsible
Plant

Profit center

Date



Solicitagdo de Cadastro de Ol e OINI

Nome OINI - PROJETO PARIS
Descricio OINI - PROJETO PARIS
Centro de Custo 7515-5001

Centro de Custo Liberador 7515-5001

Centro de Lucro 7523-10571

Categoria 30

Generg C

KRS MNdo estimado
Empresa RHPA

Divisdo 7523

Local ACTW

Data Solicitada 10/03/2017
Solicitante O, ALMEIDA

Display Project: Project Definition

'-_Iﬁ g 4% Settlement rule

Project Def. |BR.001175

\OINI - PROJETO PARIS

Long Text Exists

 /Basicdata | Control | Administration | LongText |

| Status

System Status CLSD

|

Iser status

| Project coding mask

Screen BE. 30 B0000000000N Mask 1D

| Responsibilities | Organization
Pers.Resp.Mo. 75250019 [(FALMEIDA CO area lzo2s)
Applicant no. 1 | OINI Company code [7523]

Plant [7515)

| Dates | Profit Center 7523-10571
Start date 10.03.2017 Praj.currency 'BRL |
Finish date
Factory calend. l10]
Time unit [Day]

If you need to search for the responsible, click on the icon -1



In case of doubt, search it in "Person responsible” tab.

| Responsibilities i
Pers.Resp.Mo. lm DALMEIDA
Applicant no. [& Mumber of the responsible p
Restrictions
| Dates
Start date -
v R =
o JOWEEE
m pons. Name of resp.pers
el me L — 00000033 RMATOS
Time unit Y 00004021 JLPONCHON

In "Long text", insert all the information you received from the requester.

Display Project: Project Definition
I &s £ settlement ruke

Project Def. BR.001175 (3/0INI - PROJETO PARIS [
Long Text Exists

Basic data | Control |~ Adminitration - LongText

#DE BE B B
OINI - PROJETO PARIS
Solcitacdo de Cadastro de OI e OINI

Home OINI - PROJETO PARIS
Descricdo OINI - PROJETO PARIS
Centro de Custo 7515-5001

Centro de Custo Liberador 7515-5001
Centro de Lucro 7523-10571

Categoria 30

Ganarg C

KRS Mio estimado
Empresa RHPA

Divisdo 7523

Local ACTW

Data Solbctada 10/03/2017

Sobcitante Melissa Menezes

Investimentos Acetow
(11) 49774392

In the top of the screen, click on "Details" in the field "Customer Fields".

[5 Project Edit Goto  WBS element Extras  System  Help
Q | v | &« @ WBS detail screen SHE @M

Settlement rule Shift+F7

Display Project: Projeci  Customers Fields

The IECRA must have the last digits of the profit center informed.

Add information in the fields that are in blank.



Display Project: Project Definition

I &a £ Settlernent rule

Cus Proj. [pznz e Solicitagio de Cadastro de Ol ¢ OINI
Ent. Code |zsEcTo0019 |acETOR €———————————— T ———|nome OINI - PROJETO PARIS
i ENTRE00159] FILTER TOW (TOTOW Descrigio o L AL L
Bus. unit { ) Centro de Custo 7515-5001
[enenEnnean)
IECRA Gr. CDERF0O0640| FILTER TOW (TOTO) Centro de Custo Liberador 75155001
[rem— Centro d y
IECRA IECRAO0S71| Filter tow TR 05T
Categoria 30
CO Area P— c
|
Inter cost center KRS nlo estimado
. [Err— Empresa RHPA
Position 50000790 -« Divisio o
BFC GBU To ZZZZ ACETOW-— o — hodl acTw
BFC Business Unit TOTOW T - Data Solicitada 10/03/2007
T solicitante D. ALMEIDA
| Investment Management
Scale [ Currents (< 1 MEUR)
Investment reason [a1] Miscellaneous, Administration, Facilities
Click on to go back and then in the
[E Project Edt Goto WBSelement Detals Extras  System  Hebp

@ v « ece

Display Project: Project Definition

rﬁ &8 [\ Settement rule

Here, you will include the assessment information.

Three very important points of attention:

1. In the column "WBS element", it is necessary to add the level of the project (1 = heading, 2 = project and 3 = sub-project)

2. In the column "Type", add "OI"

3. The last line of the project should have a flag in the column "CICn" (to determine that this element receives costs)




Change Project: WBS Element Overview
e @®E g 3

Proj. def. BR.001239 OINI-ESTUDO CONTENCAO ENTRADA AGUA P2 E

| BasicData | Dates | Assignments | Responsbiities | Control
e

B S Lev WBS element Description Short ID
@1 BR.001239 OINI-ESTUDO CONTENCAO ENTRADA AGUA P2 E BR.001239
2 BR.0D1239.1 Estudo para instalacdo maquina malharia BR.001239.1

R @S
Tp. Denominacio

AL Rhoda alocations

FD Various Biling

I Projeto de Investimento
IN Engineering Project

MT Maintenance

0l Projeto Despesas |

PR Services / Training

In "Total" tab, drag until the field "Cost Center" to add the number in the request.
Change Project: WBS Element Overview
a3 EZ

Proj. def. BR.001239 OINI-ESTUDO CONTENCAQ ENTRADA AGUA P2 E

| BasicData | Dates | Assignments | Responsibilties Control e

Y

/p_Pri
01 ~
01 v
01

B S Lev WBS element CA... Resp. cost... CA... Req.cost C... Costi... Over... Int. Pr...
@1 BR.001239 z025[7515-2454 Z025 7515-2454
2 BR.001239.1 2025|7515-2454 Z025 7515-2454
1

Go to Settlement Rule

1 oI v
< 2

j ﬁ D . .j j Settlement Rule

Inves... RA Key Stfiii

~

v



Fill in Cat with CTR and include the Cost Center in Settlement Receiver and press enter for the other information to be filled automatically

o .« Maintain Settlement Rule: Overview
M 4> N §[)E L& &  Plansettement

WBS element BR.001239
OINI-ESTUDO CONTENC.KO ENTRADA AGUA P2 E
Actual settlement

Distribution rules
Cat  Settlement Receiver Receiver Short Text % Se... No. S... Fro... From... To... ToFi.. First Used Last Used
(P 15-2454 PISA-Portaria UTSA 100,00 PER 1

Go to Settlement Parameters and fill the Settlement Profile with ZC and the Allocation Structure with ZT to all the WBSs.

| Change Documents » Maintain Settlement Rule: Parameters
o Details F2 tj -
{ 1 A
[% - Maintain Settl  nex: e
Previous rule L WBS element BR.001239.1
K ‘ ’ N @ Qther rules... P Estudo para instalagdo maquina malharia
WBS element BR. 001 Settlement parameters F8
OINI-ES Overview E Parameters
' Actual settlement Views 3 Description
Back 3 Settlement profile isatﬂement to cost centers
Distribution rules Allocation structure T Through cost elements of origi
PA transfer str.

Source structure
Asset Value Date
Hierarchy number
Strategy Sequence

Entered by BRBC2923 on 10.06.2019
Last changed by BRBCB8923 on 10.06.2019

Select the line, go to "Details", "Cust. Fields WBS elem".

[ Project Edit Goto WBSelement | Detsils | Extras System  Help

(/] - | « e WBS detgi screen Ctri+F9 =00 @=

Settlement rule F7

[ .| Display Project: WBS E, -

Cyst.fields WBS elem
[k a .3 . .
Delivery information
Proj. def.  |BR.001175 ' Biling plan 1
Long fext Crr+Shift+F9
Basic data | Dates | Assignments | U5 fex i
| 'S Lev|/WBS element Pri Su PE Acct Bl CO..Co.. Bu.. Phnt Profit Center Cur...
 [@h sroo1175 [ [ [ z025 7523 7515 7523-10571 BRL
| | 2 BR.DO1175.1 M| OO | [ zo2s 7523 7515 7523-10571 BRL

IECRA (it can be filled automatically)

WBS family (the standard is R&l)



Position (only if it is not filled automatically)

8 .| Display Project: WBS Element
M 4 » M [i] [Z settiement rule

Ent. Code

Bus. unit

IECRA Gr.

IECRA

Target

Interco in RCS
CO Area

Inter cost center
QTP interco

RCS IC Int.Order
Interco not in RCS
Logical system
Ext IC CtriArea
Ext IC Cost Ctr
Ext IC WBS Elt
Ext IC Int Order
WBS famiy
Position

BFC GBU

After created it's necessary to go back in the project and select all the WBSs. Enter the icon Project Definition

ksecTooo1
[ ———————

|leTow

ENTRF00159| FILTER TOW (TOTOW)

| Pe————

COPFREQ0640| FILTER TOW (IOTO)

—————
IECRRO0571| Filter tow

;e

[ —
EEGULAR

50000790

EEGULAR FROJECT

el ZZZZ RCETOW

oy

>
»

» ENTRADA AGUA .. 2

Release
&= Project d Goto  WBS element  Details Extras System Help
Select »
! o)
o - 1 000
% . Cb  Status » Release
j‘ ﬁ Project version Lock
— View » Unlock
Project def. Cancel F12 Order accepted
Technically Complete
Control Administ Cancel close techn.
"~ Fully invoiced
Status C

System Status REL
User status

Project coding mask

Close(B)

Cancel close
Deletion flag
Cancel deletion flag

Screen BR. 000K L X00000000 User Status
System/User status Shift+F6

If the request is only for creation of the heading, save it

and this process is finished.

3.2. | add a project and a sub-project

When receiving a request like in the example, note that in column C is described to create the level 2 and consequently the level 3.

pi

and go to Edit, Status and



007_PROJETOS_R&I_JUL17-L2 & e e
Arquivo  Edilar Visualizar Inserit Formatar Dados Femamentas Complementos Ajuda Todas as alieragies foram salvas no Google Drive Ei W Comentirios 2
B AP RS % 0 00123 Adal S OO U S ST ] E-+-l4-%- coEEY-I- S
A e c o € " d " J x L " u o ¢la ® s T u v
N roieto cL €. Hom
=[PERI%O = o g projete. = Shabtu — wes = sbprciele = NOME_PROJETO = NOME_SUBPROJETO = NOME_EMPRESA = NOME_AREA = momessy = Oimn = Ropens — Cenbede o NOMEOW — sociE = Dand = wocaL = [NSSEIREE=
(GBU) (6BY)
2 NOVOWBS-nivel2 BR.GPLAGR BR.GPLAGR.128 BR.GPLAGR.128411 EON EON POLIAMIDA. R8I DSA -NOVECAREAGRO  NOVECARE TI2SSE13  TI2INOMG 7823 ™28 1TRT20T Paulina Lidane Clvera

Add the number of the project (heading). This way, it is possible to verify what was already created in this project.

Display Project: Initial Screen

|

Project Def. |BR.GPLAGR
WEBS Element

In this example, a project with several lines already created.

Note that the last line created is "BR.GPLAGR.127", consequently, the next one will be "BR.GPLAGR.128".

Display Project: WBS Element Overview
It an @8 F

Proj. def.  |BR.GPLAGR 7 |AGRO_MCS NEW LA

_/Baic data ]‘ Dates | Assignments . Responsbilties | Control - Total |

S.. L... WBS element Description Short ID
1 BR.GPLAGR AGRO_MCS NEW_LA - NON-CAPI BR.GFLAGR 1
2 BR.GPLAGR.127 SPECIAL FORMULATIONS — NOMN-CAPI BR.GPFLAGR.127 t
3 BR.GPLAGR.127-01-1 SPECIAL FORMULATIONS BR.GPLAGR.127-01
@2 BR.GPLAGR.126 MCS LATAM AGRO - NON-CAPI BR.GFLAGR.126 1
3 BR.GPLAGR.126-07-1 ADJUVANTS - PHYSCHEM CHARACTERIZATION BR.GPLAGR.126-07 ]

Select the line that will be under the line you are creating and click in the button @ to open the lines.



5..L... WBS element Description
|1  BR.GPLAGR AGRO_MCS HEW_LA - NON-CAPT

g2 BR.GPLAGR.127 SPECIAL FORMULATIONS — NON-CAPT
3 BR.GPLAGR.127-01-1 SPECIAL FORMULATIONS

@2 BR.GPLAGR.126 MCS LATAM AGRO - NON-CAPI
3 BR.GPLAGR.126-07-1 ADIUVANTS - PHYSCHEM CHARACTERIZATION
3 BR.GPLAGR.126-06-1 SUMITOMO 5C FORMULA NOM-CART
3 BR.GPLAGR.126-05-1 TEA TREE QIL FORMULATIONS

More lines will be open.

Short 1D

BR

- GFLAGR 1

BR.GFLAGR.127 I
BRE.GELRGR.127-011

BR.

GFLAGR.1Z& i

BR.GFLAGR.126-07 1

BR.

GELAGR.126-06 ]

BR.GFLRGR.126=05 1

S../M... Elermento PEP Denominacdo ID breve
-1l1  BR.GPLAGR AGRO_MCS NEW_LA - NON-CAPI BR.GPLAGR
2|
2
2
For adding the project and sub-project, note the 3 very important information:
1. In the second column, add the number 2 for projects and number 3 for sub-projects
2. In the column "Type", add "OI"
3. The last level should have a flag in the column "CICn" (to determine that the costs will be allocated in this element)
In this example, the last line is the third of the sub-project
DdsBasicos }’ Datas | Atrbuicies .~ Responsabiidades |~ Controle  Total |
S.. MN... Elermento PEP Denominagao 1D breve Tp. Pri CP  Phn [CICn EIFt Stat
[E: srerLAGR AGRO_MCS NEW_LA - NON-CAPT ER.GPLAGR ol W 0O O 0Omms
@2 BR.GPLAGR.128 EON BR.GPLAGR.128 [o]] M O O[O rs
_3 BR.GPLAGR.128-01-1 EON BR.GPLAGR.128-01 OI M O [ niB
In the last tab "TOTAL", check the profit center.
5 MNiv Elemento PEP clcn EFt | Ar... E... Div...|Ce... Centro de... |Moe... Subprojeto Clas... | Equir
@1 BR.GPLAGR [ | [} zoz2s 7523 7524 7523-11143 BRL CSTIN
@2 BR.GPLAGR.128 |:| |:| EESS 7523 7524 7523-N0449 BRL CSTIN
2 BR.GPLAGR.128-01-1 []f Z025 7523 7524 ?523—N0449IL CSTIN

|} N o
c.C.
— JRespons ) Centrode
able : Lucro )
ceu)

TE28-8813 TEIIMND440

Add the cost center, after clicking on ENTER, the area will be informed automatically.




S Miv Elemento PEP Requerente Ar... |Cen.cstore... Ar... Cen.cst.so...

@1 BR.GPLAGR 7025 7525-8813 2025 7525-8813
@2 BR.GPLAGR.128 7525-8813 7525-8813
3 BR.GPLAGR.128-01-1 7525-8813 7525-8813

After that, with the selected lines go to the bottom of the screen and click on "Settlement Rule".

|:| |§| I Settlement Rule

It is necessary to determine the assessment of the project.

In the first column, add the option "CTR", in the second column add the cost center and after clicking on ENTER, other information will be filled
automatically.

Display Settlement Rule: Overview

M 4 » M G & &0 Pln settement

WBS element BR.GPLAGR.128-01-1
EON
Actual setthement
Distribution rules
Cat  Settlement Receier |Receier Short Text % Se... |No. 5... Fro... From... To .. To F... |First Used Last Used
CIR 75215%-B813 R&D No cap cost - C5 100,00 FER 1 Li] ] 008.2017 010.2017

[= Acct Assignment Cat. (2]} 2 Entries found

==

I'I;I..

In the top of the screen, click on "Goto" and select "Settlement parameters".

[ Settlementrule Edit | Goto | System  Help

) Change Documents S SR AVSE SRS @ ==

Details F2
Display&'eﬂ MNext rule
H 4 » M & & 4 revious

@

rule

p
Other rules...

WBS element BR.GPL Settlement parameters F8
EON Overview
Actual settlement Views »
Back F3

Distribution rules
Cat |Settlement Receiver | Receiver Short Text O Se... Mo. |S... Fro... From... To ... To F... First Used Last Used
CIR 25—8813 RED Mo cap cost - C5 100,00 PFER 1 L] L] 008.2017 010.2017



In the "Allocation Structure" field, add the abbreviation "ZT".

& settementrmule Edt Goto System Heb

@ | « eae
Display Settlement Rule: Parameters
WEBS elemeant BR.GPLAGR.128-01-1
EON
- Paramaters
Description RE&I DEA - NOVECARE AGRO
Settlerment profile ZD RCS Ingeneering Cost
Allocation structure ZT Through cost elements of ongi
PA transfer str,
Source structure
Asset Value Date
Hierarchy number a
Strategy Sequence
Entered by BRSO013 on 19.07.2017
| peppepepeese— |
Last changed by BRS0013 on [19.07.2017]
Click on to go back, select the line created, go to "Details" and then on "Cust.fields WBS elem".

[ Project Edit Goto  WBS element Extras  System  Help

o [ v | « @ WBS detail screen Ctrl+F9 Iﬂ
Settlement rule F?

Display Project: WBS Ei  Customers Felds

Cust.fields WBS elem

= 2 =

Fill the IECRA (with the same last digits of the profit center indicated in the request).

Complete the other fields in blank.

@]



@ .| Display Project: WBS Element
M 4 > M [ [ settement e

Ent. Code ZSECT00011
Bus. unit ENTRPO0020] NOVECARE.
IECRA Gr. CDERF00194| Novecare I
IECRA IECRA00449| Hovecare Non-LMlocated

R

=

Target ~
Interco in RCS
€0 Area _|

& Famiy (WS o

[ [E ) )5s) 2= L) (1)

WBS Family” WBS element family description  Idion———

FACLITIES  FACLITIES T
GEC GROUP ENGDIECRIG & CONSTRUCTION BT
MG OBSOLETE (02/2014) PR R
m ‘OBSOLETE (02/2014) PT
OTHERS (OBSOLETE (02/2014) T .
R&D (QBSOLETE (02/2014) PT oy . ~
R&d RESEARCH & INNOVATION PT . ~.
[ Wesfamy  [ReT | RESEARCH ¢ IMYOVATION Obs: Sempre pleenchErccampowﬂﬁmilycolﬂnpgdio R&!
Position Ern Para o campo Position em caso de divida'na identificagde.ir na aba Position do excel
N .
007_PROJETOS_R&I_JUL17-L2 & . - {atane S
| Arquive Editar Visualizar Insedr Fommatar Dados Femamentas Complementos Ajuda Toda Ges fo S Ei (] &= m :7)
S T R % g o m- A -ls /B IXrsA- % B z \"\\ A
Al e c o B . s ) . f . s o e = s i u v
.. e, NOME_
U"ﬂ‘;‘;w = Thodeproien T SRR = wé"s“i':’..‘ = it = NOME_PROJETO = NOME_SUBPROJETO = NOME_EMPRESA = NOME_AREA \ms_uu =[O = g S = MOEPMTwoar = RS = o v SRS =‘
©8Y) -~
» S niais BRGPLAGY BRGPLAGR1Z B7.GPLAGR 12911 o vt rcmo e s nasss s ‘
Go back and save it
For creating a project with reference to another one, just inform the project to be used as reference in box "Template”, field "Project def."
Create Project: Initial Screen
=
iy Open number
Project Def. EE.GEFLETE
Project Profile Z025-04 Z025 - Owerhead Costs =

Template

Project def. ER.GPFLUTI

Std proj. def.

[ |With WBS Documents

| | Temple Profile Data
The requester opens a ticket and add a file in Google Drive.

A B c D E F G H 1 J K L M N o P Q R s
Def.proj. =~ WBS element = Name T T COdEIC T N°Resp - CentCul = CentCu ~ Responsav. = Pﬂslgﬁo = Status = Pel™ T Cenluc = CédElem = Cel = Div - ArCont = Unid.Ne =
BR.GPLAGR BR.GPLAGR.123-01-1 SEED TREATMENT - ATLANTICA 3 X 7525176 T525-8813 7525-8813  Lidiane Oliveira 50025482 LIB NOLQ # TCRA RD 7523-11149 7524 Z025 ENTRP0002])
BR.GPLAUG BR.GPLAUG.101-01-1 D&A AUGEQD CLEAN 3 X 7925179 7525-8803  7525-8803 Maria Angela Pereirz 50004566 LIB NOLQ # TCRD RD 7523-11207 7525 z02s ENTRP0015
BR.GPLAUG BRGPLAUG.101-02-1 D&A AUGEOD OCTO 3 X 7525179 T525-8803 7525-8803 Maria Angela Pereirz 50004566 LIB NOLQ # TCRD RD 7523-11207 7525 Z025 ENTRP0015

CJ0o2



Inform the codification of the project.

Change Project: Initial Screen
Project Def. ' el
WBS Element |BR.GPLAGR.123-01-1 '
ENTER

Select the line.

Verify which is the status.
Change Project: WBS Element Overview
i - 2l

Proj. def.  |BR.GPLAGR ' |AGRO_MCS NEW_LA

_/ Basic data ], Dates | Assignments | Responsibiities | Control | Total |

S../L... WBS element Bil  Systemn status lUser Status

| 3 BRGPLAGR.123-01-1 T [ sEIC TCRR

First of all, block the project going to menu "Edit", click on "Status" and then on "Technically Complete".



(= Pproject Edit | Goto  WBS element  Details  Extras

0 [ Selact [ 2
Object b

C Status 3
Project wersion

0 &
View »

Proj. def. Cancel Fiz

/' Basicdata | Dates -~ Assignme

... WBS element
BR.GPLAGR.123-01-1

L
3
1
1
1
1
1

The new status will be "TECO".

Qe —hiE DHhad 8E

Release

Lock

Unlock

Order accepted

Technically Complete

Cancel close techn.
Fully invoiced
Cancel fully invoicd
Close(B)

Cancel close
Deletion flag
Cancel deletion flag
User Status
System/User status

Systern Help

@

[
[
[
| Total |
User Status
TCRR
[

F&



Change Project: WBS Element Overview
0 s @ @ T

Proj. def.  |BR.GELAGR |AGRO_MCS NEW LA

_/ Basic data ], Dates | Assignments | Responsbiities | Control | Total |

S.. L... WBS element Bil  System status IUser Status

ﬂ 3 BR.GPLAGR.123-01-1 1 kEco sETC TCRA

Depois ir em Edit - Status - CloseB

(= Pproject Edit | Goto  WBS element  Details Extras  System  Help

V] Select ' eae R OHN"oH 50 @=
Object 3
C  Status ¥ Release
Project version Lock [ 3
0w S e ,
View 9 Unlock 3
Proj. def. Cancel F12 Order accepted 4 I
Technicaly Complete
_/m data . Dates . Assignme Cancel close techn. _|‘ Total |
Fully invoiced
5../L... 'WBS element Cancel fully invoicd User Status
3 BR.GPLAGR.123-01-1 Close(B) TCRA
1 Cancel close
1 Deletion flag
1 Cancel deletion flag
| 1 User Status 3
|| 1 System/User status Fo

Then, go to "Edit", click on "Status" and then on "Close (B)".



Change Project: WBS Element Overview
' oee @ @ F

Proj. def. ER.GFLAGE AGRO_MCS MEW_LA

Basic data Dates | Assignments - Responsibilities + Control  Total

S.. L... WBS element Bl | System status User Status
3 BROGPLAGR.123-01-1 1 ELSD SETC TCRA |

The status will be "CLSD SETC".

Save it .

And see the final message.

Project BR.GPLAGR is being changed

3.5. | activate a project

It is necessary to unblock the heading, then the project and then the sub-project.

Defproj - WBSclement - Name T Lev© CGOEICICn © N°Respons - CentCuReq - CentCuRes - Responsév ~  Posici ~ Status T Perim © Typ " Cenlucr¢  CdElemFa - Centr¢ - Divisic -~ ArContCus - Unid.Negc —

BR.GSAFIB BR.GSAFIB.111-01-1 EMANA PET 3IX 7525055 7515-5503 7515-5503 GGORESCU 50002643 ENCE NOL@ // TCRD RD 752311041 7515 z025 ENTRPD007S

CJ0o2

Change Project: Initial Screen

Project Def. BER.GSLFIE
WBS Element 3

In this case, the heading is open but the project and the sub-project are closed.



Change Project: WBS Element Overview
[0 e [ E B F

Proj. def. |BR.GSRFIB [ Fibras_Projetos RED

Basic data ], Dates FAssignments |, Responsibilities |fControI F Total |

&.. L... WBS element Typ Pri Su  PE Acct Bil |System status
[Elr  er.GsAFB RD 1O [ REL
[El2  er.GsAFB.113 RD M| 0O 0| 0O ke

3 BR.GSAFIB.113-01-1 RD W | O & | O REL SETC
[El2  BrEsAFB.112 RD M O OO cwso

3 BR.GSAFIB.112-01-1 RD W | J| & | [ cLSD SEIC
[E]2  er.GsaFB.111 RD Tl [ [ ctsp

3 BR.GSAFIB.111-01-1 RD ] [] cLsp sETC

Select the blocked lines.

Go to "Edit", click on "Status" and then on "Cancel close".

= Project | Edit | Goto  WBS element  Defails Extras  System  Help

User Status
TCRR
ICEL
ICEL
ICRD
TCRD
TICRD
TICRD

V] Sglect @I CHR DDON

Object 3
C Status » Release
Project version Shift+F4 Lock
Y 2
View 3 Unlock
Proj. def. Cancel = Order accepted

Technicaly Completa

’_/Basicdala }, Dates | Assignments | Re Cancel close techn.

Fully imvoiced
§..L... WBS element Cancel fully invoicd
@1 BRGSAFB Close(B)
[Elz  BR.GSAFIB.113 Cancel close

The status will be "TECO".



Change Project: WBS Element Overview
e DEE T

Praj. def. |BR.GSAFIB || Fibras_Projetos R&D

’_/ Basic data }f Dates . Assignments | Responsbilties | Control | Total |

5.. L... |WBS element Typ |Pri Su PE |Acct Bil |Systermn status lUser 5t
[El1  BR.GSAFIE RD 0O 0O [ R TCRA
[El2  BR.GSAFE.113 RD ¥ | O [0 [ Re TCRR
3 BR.GSAFIB.113-01-1 ED M | ]| ¥ | [] REL SEIC TCRL
[El2  BR.GSAFIB.112 RD M 0O 0O [0 fczso TCRD
3 BR.GSAFIB.112-01-1 ED M| ]| ¥ | [ cLsp SETC TCRD
:I@z BR.GSAFIB.111 RD W 1 1 [ =co TCRD
3 BR.GSAFIB.111-01-1 ED Wl 1 [« [1 TECO SETC TCRD
Go to "Status" and click on "Cancel close techn.".
(= Pproject Edit | Goto  WWBS element Details Extras  System  Help
V] Select & HH™aH
Object 3
C  Sstatus 3 Release
Project version Shift+F4 Lock 3
Bal °
View 9 Unlock 3
Proj. def. Cancel F12 Order accepted o

Technicaly Complete

. Basicdata | Dates | Assignments | Re Cancel close techn.

Probably, you will receive an error message.

[E- Status management: Revoke technical completion

I Status informatio I

The business transaction

cannot be carried out.

I Cont. I

Go to "Status", click on "User Status" and then "Set".



(& Project @ Goto  WBS element  Details
G | Select 3 ﬁ
Object 3
C  status 3
B & [ Project wersion Shift+F4
View »
Proj. def. Cancel F12

R

 / Basicdata | Dates .~ Assignments

S.. L... |\WWBS element

BR.GSAFIB
BR.GSAFIB.113

3 BR.GSAFIB.113-01-1

BR.GSAFIB.112

3 BR.GSAFIB.112-01-1

BR.GSAFIB.111
BR.G5AFIB.111-01-1

BR.GSAFIB.110

Click twice on "Tech compl revoke Allowed".

v )[BR) @) P
StHo Stat Status
BLQE Commitment Locked
BLOQP Time Locked
MASD WBS rmasked
10 TCRA Tech comnpl revoke Allowed
20 TCRD Tech compl revoke Disallowed

You will receive the following message.

[S User Status: Display messages

Extras  System  Help
MEONDILH N0 @=
Release
Lock 3
Unlock [ 2
Order accepted 2

Technicaly Complete
Cancel close techn.

Fully invoiced
Cancel fully invoicd System status
Close(B) EEL
Cancel close EEL
Deletion flag BEL 5SEIC
Cancel deletion flag CLSD
User Status k Set
System/User status Fo Undo
H” CiNmEEs . Set & Pass On
RD 1| 11

v |

—

vp | Ite |Message text

001 |Element: BR.GSAFIE.111
001 |User Status TCRA Set
002 |Element: BR.GSAFIBE.111-01-1
002 |User Status TCRA Set

— Person responsible: GEORESCO

— Person responsible: GEORESCO

..

Undo & Pass On

:Zkif Technical Information ]@EE}@@[@ 0 ”@ 0 ”ﬂ, 0 ”E‘ 4

H H 4 A



Click on .

Do the step again: Go to "Status", click on "Cancel close techn.".

= Project | Edit | Goto  WBS element  Defails Extras  System  Help

V] Sglect @I CHBR DDOY

Object »
C  Status » Release

Project version Shift+F4 Lock b
G R °

View 3 Unlock 3
Proj. def. Cancel F12 Order accepted |

Technically Complete

Rasic data | Dates - Assionments LE Cancel close techn.

The status will change.

Proj. def. |BR.GSRFIB ' Fibras_Projetos R&D

_/Baic data ], Dates . Assignments - Responsibiities © Control . Total |

5.. L... |WBS elerment Typ |Pri Su PE |Acct |Bil | Systemn status User 5tz
@1 sr.GsAFE RD M 0O 0O O R TCRA
[Elz  BR.GSAFIB.113 RD M [0 O [ ReL TCRA
3 BR.GSAFIB.113-01-1 RD W | [1 W | [] BEL SEIC TCRA
@]z BR.GSAFE.112 RD M [ [ [] cwso TCRD
3 BR.GSAFIB.112-01-1 RD M| ]| & | [] cLsp SEIC TCRD
@z BR.GSAFB.111 RD 7 [ [ REm TCEA
B BR.GSAFIB.111-01-1 RD [ | REL SETC TCRA
[ ]
Save it H .
3.6. | change the name of the project
The requester will send the information in the template.

Go to transaction CJO02.

Inform the codification of the project.



Change Project: Initial Screen

Project Def.
WBS Element BR.GCEAMI.102-01-1 7

Change the description according to the information in the template .

|.| Change Project: WBS Element Overview
A E S

Proj. def. ER.GCERMI APOID ANALITICO - NOVECARE

Basic data Dates ~ Assignments - Responsbiities + Control - Total

S.. L... 'WBS element Description
3 BR.GCEAMI.102-01-1

|.| Change Project: WBS Element Overview
B e s

Proj. def. BR.GCERMI APOIO AMALITICO - NOVECARE

Basic data Dates ~ Assignments - Responsbiities + Control - Total

Short 1D
ANALISES DE ACORDOS COMERCIAIS - NOVECAR BR.GCEAMIL102-01 ED

Typ

S.. L... |'WWBS element Description
3  BR.GCEAMI.102-01-1

g .

Save it

End of document.

Short ID

Typ Pri

ANALISES DE ACORDOS COMERCIAIS - NOVECAR BR.GCEAMI.102-01 RD

Su
"]l

PE
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